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Σχεδιασμός και Ανάλυση Πτέρυγας 

 

Περίληψη 
Σε αυτήν την εργασία, εξετάζεται ο σχηματικός έλεγχος εύκαμπτων κατασκευών 

χρησιμοποιώντας ενισχυμένες παραμορφώσεις ως ενέργειες ελέγχου. Το 

προτεινόμενο σχήμα μπορεί να εφαρμοστεί για τη μορφοποίηση των δομών δοκών, 

όπως βάσεις ράδιο-τηλεσκοπίου, έξυπνες πτέρυγες αεροσκαφών, μπούμα 

ψεκασμού κλπ. Θεωρείται ένα στατικό πρόβλημα για διαφορετικά εξωτερικά φορτία. 

Για τον έλεγχο του σχήματος της κατασκευής, εφαρμόζονται κατάλληλα 

σχεδιασμένες παραμορφώσεις επιλεγμένων δομικών μελών. Οι εφαρμοσμένες 

παραμορφώσεις σε επιλεγμένα στοιχειά ελέγχου μπορούν να πραγματοποιηθούν 

μέσω πολλών τεχνολογιών: θερμικές τάσεις, πιεζοηλεκτρικά φορτία, ενεργοποιητές 

μνήμης σχήματος κλπ. Το σχήμα της δομής αλλάζει ανάλογα με τις περιβαλλοντικές 

συνθήκες. Για παράδειγμα, για να υπάρχει ο βέλτιστος έλεγχος της γεωμετρικής 

δοκιμής της έξυπνης πτέρυγας του αεροσκάφους, θα πρέπει να τροποποιηθεί 

ανάλογα με τα καιρικά φαινόμενα, την αναταραχή του αέρα, την πίεση, την ταχύτητα 

ροής και άλλα.  Στην παρούσα εργασία, παρουσιάζονται τα διακριτά βήματα αλλαγής 

σχήματος της δομής, η οποία βρίσκεται υπό εξωτερική φόρτωση και έλεγχο, καθώς 

η σχεδίαση και η ανάλυση έξυπνης πτέρυγας στο περιβάλλον του σχεδιαστικού 

προγράμματος NΧ Siemens.   

 

Σημαντικοί Όροι: Έλεγχος σχήματος, Έξυπνες Κατασκευές, Θερμικές φορτίσεις, 

Έξυπνες πτέρυγες, Δίσκοι, NX Siemens. 
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Wing Design and Analysis 

 

Abstract 
In this work, shape control of flexible structures using enforced deformations as 

control actions is considered. The proposed scheme can be applied for morphing of 

truss structures, such as a radio-telescope bases, aircraft smart wings, spray booms 

etc. A static problem for different external loadings is considered. In order to control 

the shape of the structure, suitably designed deformations of selected structural 

members are applied. Applied deformations on selected control elements can be 

realized by means of several technologies: thermal stresses, piezoelectric effects, 

shape memory actuators etc. The shape of the structure is changed according to the 

environmental conditions. For instance, in order to have an optimal control of 

geometry of the aircraft smart wing, it should be modified in dependence of weather 

phenomena, air turbulence, pressure, flow velocity and others. In this paper the 

discrete steps of shape changing of the structure, which is under external loading and 

control, are shown. 

Keywords: Morphing, Smart structures, Thermal forces, Smart wings, Trusses, NX 

Siemens. 
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ΚΕΦΑΛΑΙΟ 1: ΣΧΗΜΑΤΙΚΟΣ ΕΛΕΓΧΟΣ ΕΥΚΑΜΠΤΩΝ ΚΑΤΑΣΚΕΥΩΝ 

 

1.1 Εισαγωγή 
Έλεγχος σχήματος και αναγνώρισης ζημιών σε έξυπνες κατασκευές, 

συμπεριλαμβανόμενων πιεζοηλεκτρικών στρωμάτων, έχει προταθεί στο [1]. Δηλαδή, 

μια δομή δοκού που είναι εξοπλισμένη με συνδεδεμένη πιεζοηλεκτρική 

ενεργοποίηση, η οποία παρέχει τις δυνάμεις ελέγχου, και η γενετική βελτιστοποίηση 

εξετάζεται και δοκιμάζεται.  Η μαθηματική μοντελοποίηση βασίζεται στη διατμητική 

παραμόρφωση της θεωρίας Timoshenko beam και στην αρχή του Hamilton, σε 

συνδυασμό με τη γραμμική πιεζοηλεκτρική ενέργεια.  Αναπτύσσονται πεπερασμένα 

στοιχειά χωρίς κλειδώματα, ενώ οι βέλτιστες θέσεις των πιεζο-ενεργοποιητών και οι 

βέλτιστες τάσεις για τον έλεγχο του σχήματος λαμβάνονται με τη γενετική 

βελτιστοποίηση. Στατικά δεδομένα και γενετική βελτιστοποίηση χρησιμοποιούνται 

για την επίλυση του σχετικού προβλήματος αναγνώρισης ζημιών.  Από τα αριθμητικά 

αποτελέσματα φαίνεται ότι μόνο ένας μικρός αριθμός ενεργοποιητών μπορεί να 

επιτύχει έλεγχο σχήματος της δομής αποτελεσματικά, δεδομένου ότι τοποθετούνται 

βέλτιστα και έχουν βέλτιστες τιμές τάσης. 

Ο όρος μορφοποίηση μπορεί να χρησιμοποιηθεί για να περιγράψει ένα ευρύ 

φάσμα στοιχείων που ανταποκρίνονται στις δομικές απαιτήσεις συνθέτων 

συστημάτων όπως οι έξυπνες πτέρυγες των αεροσκαφών. Αυτή η προσαρμογή 

περιλαμβάνει συνήθως την αλλαγή του σχήματος σε πραγματικό χρόνο, π.χ. 

τροποποίηση του σχήματος των πτερυγίων κατά τη διάρκεια της πτήσης (βλέπε 

μεταξύ άλλων (2-3)).  

     Η μορφοποίηση των οχημάτων και των κατασκευών της αεροδιαστημικής 

αναφέρεται σε βάθος στο [4].  Δηλαδή, παρέχεται η τελευταία λέξη της τεχνολογίας, 

μερικές μελλοντικές κατευθύνσεις, καθώς και όλες οι τεχνικές απαιτήσεις των 

μορφών μορφοποίησης.  Ιδιαίτερη έμφαση στην πτήση ελέγχου, αεροδυναμική και 

υλικά, καθώς και δομές των οχημάτων.  Τέλος, συζητούνται επίσης πτυχές όπως οι 

απαιτήσεις ισχύος καθώς και η χρήση έξυπνων υλικών, όπως προηγμένα υλικά piczo 

και έξυπνοι ενεργοποιητές.   

     Ο βέλτιστος σχεδιασμός έξυπνων συνθέτων υλικών συζητείται στο [5].  Μια 

σημαντική πτυχή είναι ότι πέρα από την κλασική βελτιστοποίηση σχήματος και 

διάταξης, η βελτιστοποίηση κατά σημείο μπορεί να παρέχει πλήρως λειτουργικά 

διαβαθμισμένα σύνθετα υλικά. Άλλα έξυπνα υλικά όπως κράματα μνήμης σχήματος 

(SMA) και πολυμερή μνήμης σχήματος (SMP) μπορούν επίσης να χρησιμοποιηθούν 

για το σκοπό αυτό.  Για παράδειγμα, στο [6] συζητείται ο εννοιολογικός σχεδιασμός, 

η κατασκευή πρωτότυπων και η αξιολόγηση της μορφής πτέρυγας που χρησιμοποιεί 

έξυπνα υλικά.  Τα αποτελέσματα δείχνουν ότι οι ανταγωνιστικές δομές κάμψης που 

ενεργοποιούνται με SMA δημιουργούν μια τεχνολογία ενεργοποίησης που μπορεί να 

χρησιμοποιηθεί για μορφοποίηση πτερυγίων μικρών αεροσκαφών.  Μια προσέγγιση 

που χρησιμοποιεί κράματα μνήμης σχήματος (SMAs) και σύνθετα μακρό-ινών (MFC) 
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στο πίσω άκρο μια έξυπνης πτέρυγας παρουσιάζεται στο [7].  Στο πρόσφατο έργο των 

Wang et al. [8] Η ανατροφοδότηση χρησιμοποιείται επίσης για δυναμική 

μορφοποίηση εύκαμπτων πτερυγίων με πιεζοσύνθετα υλικά.   

     Στην παρούσα έρευνα, θα παρουσιαστούν τεχνικές δομικής ανάλυσης μήτρας για 

έλεγχο σχήματος δομών δοκών.  Τα θερμικά φορτία χρησιμοποιούνται ως όχημα για 

την εισαγωγή ενεργειών στατικού ελέγχου, όπως περιγράφεται στο [9] , αν και οι 

τεχνολογίες πιεζοηλεκτρικής μνήμης η σχήματος μπορούν να χρησιμοποιηθούν αντί 

για μικρές αλλαγές. Η διατύπωση καλύπτει δομές και μηχανισμούς και μπορεί να 

χρησιμοποιηθεί για την μελέτη των ανταγωνιστικών όρων ελέγχου και βέλτιστης 

ακαμψίας, όπως περιγράφεται στο βιβλίο των Connor & Laflamme [10]. Επιπλέον, 

στην περίπτωση μορφοποίησης έξυπνων συμβατών μηχανισμών, η τοπολογία 

βελτιστοποίησης μπορεί να χρησιμοποιηθεί για την διαμόρφωση του μηχανισμού 

όπως παρουσιάζεται στο [11].  Σε δυναμικά προβλήματα, η δυναμική μορφοποίηση 

έξυπνων ζευκτόντων και μηχανισμών μπορεί να επιτευχθεί με τη χρήση μαλακών 

υπολογιστών όπως ασαφείς και νεύρο-ασαφείς τεχνικές. Μια πρώτη προσέγγιση για 

τη δυναμική μορφοποίηση του σχήματος έξυπνων βάσεων ράδιο-τηλεσκοπίου, μέσω 

συστήματος νευροασαφούς ελέγχου, παρουσιάστηκε στην εργασία [12]. .  Η σύζευξη 

του ελέγχου σχήματος με τη δυναμική μορφοποίηση αντιπροσωπεύει ένα τομέα 

ενδιαφέρουσας μελλοντικής έρευνας. 

 

1.2 Διατύπωση του προβλήματος 
Για μια δομή, δίνεται θερμική παραμόρφωση μονοδιάστατου στοιχείου ράβδου 

ως:  

    {𝜀𝑇 } = {𝑎Δ𝑇}      (1) 

Όπου το α είναι ο συντελεστής θερμικής διαστολής και το ΔT είναι η θερμική 

διέγερση. 

Αυτή η παραμόρφωση μπορεί να ληφθεί υπόψη σε μια στατική ανάλυση 

πεπερασμένων στοιχείων μέσω ισοδύναμων κομβικών δυνάμεων της φόρμας: 

    {𝑓𝑇} = {
−𝐸𝑎𝛥𝑇
𝐸𝑎𝛥𝑇

} 𝐴        (2) 

Όπου το E είναι το μέτρο ελαστικότητας και το Α είναι η διατομή της ράβδου. 

Επομένως, σε επίπεδο στοιχείου έχει 

    [𝐾𝑒]{𝑢} = {𝑓𝑀} + {𝑓𝑇}     (3) 

Όπου το  fM είναι οι μηχανικές κομβικές δυνάμεις και το fT είναι οι θερμικές 

κομβικές δυνάμεις, ενώ το Ke είναι το στοιχείο δυσκαμψίας και το u ο φορέας 

μετατόπισης. Σε δομικό επίπεδο, μετά την κλασσική συναρμολόγηση των 

πεπερασμένων στοιχείων, αποκτά κανείς 

    𝐾𝑢 = 𝑓 + 𝐴𝑤
‾

      (4) 
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όπου το w είναι ο θερμικός συντελεστής όλων των θερμικά ενεργοποιημένων 

ράβδων, οι οποίες μπορούν να χρησιμοποιηθούν ως μεταβλητές ελέγχου και το Α 

είναι μια κατάλληλη μήτρα επιρροής που προέρχεται από τη συνδεσιμότητα των 

πεπερασμένων στοιχείων. Το K, u και f είναι η μήτρα ακαμψίας, το διάνυσμα 

μετατόπισης και το διάνυσμα δύναμης αντίστοιχα. 

Ένα σχηματικό πρόβλημα βέλτιστου ελέγχου μπορεί να διαμορφωθεί ως 

πρόβλημα ελαχιστοποίησης ελαχίστων τετραγώνων 

 

𝑚𝑖𝑛 {(𝑢 − 𝑢0)𝑇𝐿(𝑢 − 𝑢0)+
1

2
𝑤𝑇𝑄𝑤}    (5) 

που υπόκειται στις εξισώσεις ισορροπίας της κατάστασης (4). Τα L και Q είναι πίνακες 

βάρους και το u0 είναι το επιθυμητό διάνυσμα μετατόπισης που καθορίζει το τελικό 

αποτέλεσμα του σχηματικού ελέγχου. 

Το πρόβλημα (5) είναι μια συμβιβαστική βελτιστοποίηση, όπου οι τιμές των L και 

Q καθορίζουν τη σημασία της ικανοποίησης του στόχου και του κόστους ελέγχου, 

αντίστοιχα. Ο συνδυασμός της τετραγωνικής βελτιστοποίησης (5) με το γραμμικό 

στατικό δομικό μοντέλο (4) είναι απλός. Παρ 'όλα αυτά, οι πρόσθετες απαιτήσεις, 

είτε στη λειτουργία βελτιστοποίησης είτε στη δομή, όπως η επιτρεπόμενη πίεση ή οι 

περιορισμοί λυγισμού, καθιστούν το αντίστοιχο βέλτιστο πρόβλημα σχεδιασμού πιο 

περίπλοκο. Το ίδιο συμβαίνει και στην περίπτωση ενός μηχανισμού, όπου ο πίνακας 

ακαμψίας K στο (4) είναι μοναδικός, βλ. (9). Ένα γενικό σχέδιο γενετικής 

βελτιστοποίησης μπορεί να χρησιμοποιηθεί για την επίλυση τέτοιων προβλημάτων, 

αν και ακόμη και οι τοπικές τεχνικές βελτιστοποίησης μπορούν να εφαρμοστούν για 

συγκεκριμένες εφαρμογές. 

Προκειμένου να δοθεί ένα συγκεκριμένο αριθμητικό παράδειγμα, μελετάται η 

έξυπνη πτέρυγα του Σχ. 1. Το εσωτερικό τμήμα αυτής της πτέρυγας είναι 

διαμορφωμένο ως δομή στήριξης 2D, όπως φαίνεται στην Εικ. 1. Πρέπει να 

σημειωθεί εδώ ότι οι ράβδοι που φέρουν σήμανση με παχύτερες γραμμές, είναι 

θερμικά φορτισμένες, σύμφωνα με τον μηχανισμό που περιεγράφηκε παραπάνω. 

     Οι ράβδοι που φορτίζονται θερμικά προκαλούν αλλαγές στη μορφή της δομής της 

κατασκευής και αυτή η ιδιότητα μπορεί με τη σειρά της να χρησιμοποιηθεί για την 

τροποποίηση του τελικού σχήματος της έξυπνης πτέρυγας, το οποίο είναι και το 

επιθυμητό αποτέλεσμα της μορφοποίησης των φτερών. Επιπλέον, αυτή η διαδικασία 

μπορεί να χρησιμοποιηθεί ως πρωτότυπο και μπορεί να λειτουργήσει με άλλες 

τεχνολογίες, όπως πιεζοηλεκτρικά ή SMAS.  
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 Εικ. 1.1. Έξυπνη πτέρυγα με εσωτερικό τμήμα δοκών. Οι παχύτερες γραμμές υποδηλώνουν τις ράβδους που είναι 
θερμικά φορτισμένες. 

 

1.3 Αριθμητικά παραδείγματα και συζήτηση  
Στην παρούσα ερευνά, συζητούνται δύο διαφορετικά σενάρια.  Για το πρώτο 

σενάριο, μια ισχυρή κατακόρυφη δύναμη F = 1000N εφαρμόζεται στο ελεύθερο άκρο 

της δομής. Όσον αφορά το δεύτερο σενάριο, οι ισοδύναμες δυνάμεις των άνω 

κόμβων θεωρούνται υψηλές, με 𝑓𝑇1 = 𝑓𝑇2 = 1000N, ενώ οι ισοδύναμες δυνάμεις των 

κάτω κόμβων είναι χαμηλές, με 𝑓𝑇3 = 𝑓𝑇4 = −1000N, και σύμφωνα με την Εξ. 2 . 

Το υλικό της δοκού είναι από χάλυβα με συντελεστή Young Ε = 200GPa, διατομή 

Α=0,1 m2 και συντελεστής θερμικής διαστολής α = 13∙10−6 ℃−1. Έτσι από την Εξ. 2, 

ΔΤ=3,85∙10-3 0C. Το αρχικό και το παραμορφωμένο εσωτερικό τμήμα της έξυπνης 

πτέρυγας για το πρώτο και το δεύτερο σενάριο φαίνονται στις Εικ. 2 και 3, τα 

αποτελέσματα προκύπτουν από υπολογισμούς στο περιβάλλον της MATLAB. 

 

 Εικ. 1.2. Αρχικές (με διακεκομμένη γραμμή) και παραμορφωμένες (με συμπαγή γραμμή) δοκοί για το πρώτο         
σενάριο. 
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 Εικ. 1.3. Αρχικές (με διακεκομμένη γραμμή) και παραμορφωμένες (με συμπαγή γραμμή) δοκοί για το δεύτερο 
σενάριο. 

Περισσότερες πληροφορίες είναι διαθέσιμες στην πρόσφατη εργασία [15].  
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ΚΕΦΑΛΑΙΟ 2: ΠΤΕΡΥΓΑ ΣΕ ΑΠΛΗ ΜΟΡΦΗ 2D 
 

2.1 ΝΧ Siemens 
Το NX Siemens αποτελεί ένα ολοκληρωμένο CAD/CAM/CAE/PLM λογισμικό που 

παρέχει στο χρήστη τη δυνατότητα του σχεδιασμού, της παραγωγής, της ανάλυσης 

της μηχανικής συμπεριφοράς και της μελέτης του κύκλου ζωής των προϊόντων που 

σχεδιάζονται. Διατίθεται από τη SIEMENS και χρησιμοποιείται ευρέως σε όλους τους 

κλάδους της βιομηχανίας με διευρυμένη χρήση ειδικά στην αυτοκινητοβιομηχανία 

και την αεροναυπηγική. Ειδικότερα, οι γεωμετρικές διαστάσεις ενός αντικειμένου 

συνδέονται μεταξύ τους με διάφορες συναρτησιακές σχέσεις έτσι ώστε αν 

μεταβληθεί μία διάσταση από τον χρήστη, τότε να μπορούν να τροποποιούνται 

αυτόματα όσα χαρακτηριστικά του αντικειμένου συνδέονται άμεσα με αυτή. Το 

γραφικό περιβάλλον των συστημάτων και των υποσυστημάτων του είναι ιδιαίτερα 

φιλικό και διαδραστικό για τον χρήστη και παρέχει ευρεία γκάμα δυνατοτήτων. 

2.2 Σχεδίαση  
Σκοπός του κεφαλαίου αυτού είναι η σύγκριση των αποτελεσμάτων της πτέρυγας 

στο NX Siemens με αυτά της Matlab, βλ. Εικ. 1.3.   

Αρχικά σχεδιάστηκε στο περιβάλλον του ΝΧ το 2D μοντέλο της πτέρυγας, όμοιο με 

αυτό του κεφαλαίου 1, βλ. Εικ. 1.1. Οι συντεταγμένες των κόμβων της πτέρυγας, οι 

οποίες είναι γνωστές, περάστηκαν στο ΝΧ μέσω ενός αρχείου txt. Ενώνοντας τους 

κόμβους με την εντολή Line, η οποία δημιουργεί γραμμές, δημιουργήθηκε το τελικό 

ακόλουθο αποτέλεσμα.  

 

Εικ. 2.1. Έξυπνη πτέρυγα σε 1D (NX Siemens) 

Στην συνέχεια, θα φορτιστούν θερμικά οι δοκοί με τον κόκκινο χρωματισμό. Αυτό 

επιτυγχάνεται με το NX να έχει την δυνατότητα για θερμικές και δομικές λύσεις, 

καθώς και να δίνει την προσομοίωση της τελικής μορφής του μοντέλου στο χρήστη.  
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2.3 Μοντελοποίηση και ορισμός παραμέτρων 
Για την ένταξη της θερμικής φόρτισης χρησιμοποιήθηκε η εντολή New FEM and 

Simulation. Η κατασκευή είναι σε 2D κι έπρεπε να γίνουν κάποιες αλλαγές στο 

Geometry option, επιλέχθηκαν να εμφανιστούν τα sketch curves και τα points. 

 

Εικ. 2.2. Geometry Options. 

Ορίζεται η επιθυμητή επίλυση, από το solution type με το SOL101 Linear Statics – 

Global Constraints, εφόσον έχουμε να κάνουμε με απλή γραμμική – στατική ανάλυση. 

Σε αυτήν την περίπτωση θα οριστούν μόνο τα δεδομένα εξόδου, τα οποία θα 

τυπωθούν στην ανάλυση. 

Στο Case Control -> Output επιλέχθηκαν οι default επιλογές. 

 

Εικ. 2.3. Solution. 

Έπειτα, εφόσον έχει οριστεί η επίλυση, ακολουθεί η ανάλυση. 
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2.3.1 Ανάλυση 
Τα βασικά στάδια της ανάλυσης είναι: 

1) Δημιουργία του Mesh Collector 

2) Δημιουργία του Mesh 

3) Ένταξη των συνοριακών συνθηκών (Boundary conditions) 

4) Ένταξη των δυνάμεις (Loads) 

 

Στο Mesh Collector αποθηκεύονται οι βασικές πληροφορίες της κατασκευής που 

θα περαστούν στο mesh, όπως το υλικό που χρησιμοποιήθηκε,  το είδος του 

πεπερασμένου στοιχείου (element). 

Ως Mesh ορίζεται η διαίρεση της κατασκευής σε πολλά επιμέρους τμήματα, με 

σκοπό να επιλυθεί ένα προς ένα, ώστε να προκύψει σαν αποτέλεσμα η τελική 

συμπεριφορά της κατασκευής. Όσο σε πιο πολλά τμήματα διαιρεθεί η κατασκευή, 

τόσο μεγαλύτερη ακρίβεια στο τελικό αποτέλεσμα. 

Στην 1D ανάλυση το mesh collector έχεις πληθώρα επιλογών για πεπερασμένα 

στοιχεία που μπορούν να χρησιμοποιηθούν. Οι διαφορές ανά περιπτώσεις είναι 

μεγάλες, στην περίπτωση της πτέρυγας επιλέχθηκε το beam collectors, που 

ουσιαστικά  δίνει τη δυνατότητα μελέτης τριών βαθμών ελευθερίας κάθε κόμβου 

(μετακίνηση στον Χ -> T1, μετακίνηση στον Y -> T2 και περιστροφή R3). 

Έπειτα από την επιλογή του beam collector, στο κομμάτι Physical Property -> Type 

θα παρέμειναν οι default επιλογές. Στο Beam property -> none, πατώντας το Create 

Physical, ορίστηκαν οι παράμετροι του στοιχείου και το υλικό. Επίσης, ορίστηκε το 

Fore Section, για να δοθεί η διατομή στο στοιχείο, αφού θα έχει τη μορφή μίας δοκού. 

 

Εικ. 2.4. PBEAML. 

Επιλέγοντας το Show Section Manager, από το type επιλέχθηκε η διατομή ROD ίση 

με Α=0,1 m2 , δηλαδή με διάμετρο DIM1=0.1784m. 
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Εικ. 2.5. Διατομή ROD. 

Δημιουργήθηκε το συγκεκριμένο επιθυμητό υλικό για την πτέρυγα, το οποίο είναι 

από χάλυβα με Young’s modulus E=200GPa και λόγο Poisson 0.2. 

 

 

Εικ. 2.6. Βιβλιοθήκη υλικών. 
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Εικ. 2.7. Μηχανικές ιδιότητες. 

 

Εικ. 2.8. Θερμικές ιδιότητες. 

Εφόσον έχει δημιουργηθεί το mesh collector, σειρά έχει το 1D Mesh. Το πρώτο 

πράγμα που πρέπει να γίνει είναι από το Select Object  να επιλεχθεί ολόκληρη η 

πτέρυγα, όπου και θα γίνει το mesh. Από το element properties επιλέγεται το είδος 

του στοιχείου που θα χρησιμοποιηθεί. Απενεργοποιείται η εντολή Automatic 

Creation στο Destination Collector. 
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Εικ. 2.9. 1D Mesh. 

Έπειτα, ενώθηκαν οι κόμβοι μεταξύ των πλευρών με την εντολή merge nodes που 

βρίσκεται στο Duplicate Nodes. 

 

Εικ. 2.10. Duplicate Nodes. 

2.3.2 Συνοριακές συνθήκες και φορτίσεις 
Εφόσον έχουν οριστεί τα υλικά, έρχεται η σειρά του επόμενου βήματος, το οποίο 

είναι να εφαρμοστούν οι φορτίσεις (loadings) και οι συνοριακές συνθήκες (boundary 

conditions). Πατώντας το Active Simulation μπορούμε να προχωρήσουμε στα 

παρακάτω. Από το Constrain Type επιλέγω την συνοριακή συνθήκη που επιθυμώ και 

αυτή είναι Fixed Constrain, επιλέγοντας την αριστερή έξω δοκό της πτέρυγας. 
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Εικ. 2.11. Fixed Constraint. 

 

Εικ. 2.12. Συνοριακή συνθήκη. 

Στην συνέχεια, εφαρμόζονται οι θερμικές φορτίσεις στις κόκκινες δοκούς της 

κατασκευής, επιλέγοντας Load Type->Temperature και βάζοντας αρχική 

θερμοκρασία 20 οC.  
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Εικ. 2.13. Temperature. 

Για να δημιουργηθεί το επιθυμητό ΔΤ=3,85∙10-3 οC του δεύτερου σεναρίου βλ. 

Κεφάλαιο 1, από το Temperatures δημιουργήθηκε Now Load Set-> Temperature Set 

για την πάνω και την κάτω κόκκινη δοκό ξεχωριστά. Στην πάνω δοκό επιλέχθηκε 

Initial/Stress Free Temperature και στο Property επιλέχθηκε Default Temperature με 

θερμοκρασία ίση με 20+3.85∙10-3 οC, ενώ στην κάτω κόκκινη δοκό με θερμοκρασία 

ίση με 20-3.85∙10-3 οC. Με αυτό τον τρόπο επιτεύχθηκε η  θέρμανση της πάνω δοκού 

και η ψύξη της κάτω, κατά το επιθυμητό ΔΤ. 

 

 

Εικ. 2.14. Θέρμανση πάνω πορτοκαλί δοκού. 
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Εικ. 2.15. Ψύξη κάτω πορτοκαλί δοκού. 

 

Εικ. 2.16. Θερμικές φορτίσεις. 

2.4 Επίλυση και προσομοίωση 
Σε αυτό το σημείο, εφόσον έχουν οριστεί όλα, ακολουθεί το τρέξιμο του 

προγράμματος, από το Solution-> Solve. 
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Εικ. 2.17. Επίλυση. 

Από το Results κι έπειτα πατώντας στο Structural, παίρνουμε ως αποτέλεσμα την 

τελική μορφή της πτέρυγας.  

 

Εικ. 2.18. Τελικό παραμορφωμένο σχήμα ( με γκρι χρώμα το αρχικό). 
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Εικ. 2.19. Τελικό παραμορφωμένο σχήμα ( με γκρι χρώμα το αρχικό), μεγάλο scale. 

 

Εικ. 2.20. 

 

2.5 Συμπεράσματα 

     Με την σύγκριση της πτέρυγας που σχεδιάστηκε στο NX Siemens και με την 

πτέρυγα του δεύτερου σεναρίου, βλ Εικ. 2.22, μπορούμε να καταλήξουμε στο 

συμπέρασμα πως το τελικό σχήμα και των δύο μετά από τις φορτίσεις έχει την ίδια 

μορφή. Επομένως, το NX Siemens μας έδωσε ίδια αποτελέσματα με την MATLAB.  
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Εικ. 2.21. Πτέρυγα ΝΧ Siemens. 

 

Εικ. 2.22. Πτέρυγα Matlab. 
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ΚΕΦΑΛΑΙΟ 3: ΠΤΕΡΥΓΑ ΠΡΑΓΜΑΤΙΚΩΝ ΔΙΑΣΤΑΣΕΩΝ 2D 

 

3.1 National Advisory Committee for Aeronautics (NACA) 
Το NACA 4 digit airfoil generator είναι μία γεννήτρια πτερύγων, που δίνει την 

δυνατότητα επιλογής διάστασης πτέρυγας και εξαγωγής των συντεταγμένων των 

κόμβων. Η NACA ανέπτυξε αρχικά το αριθμημένο αεροπορικό σύστημα, το οποίο 

βελτιώθηκε περαιτέρω από την Πολεμική Αεροπορία των Ηνωμένων Πολιτειών στο 

Langley Research Center, υπό την καθοδήγηση του Eastman Jacobs. Σύμφωνα με τον 

ιστότοπο της NASA:  Στα τέλη της δεκαετίας του 1920 και στη δεκαετία του 1930, η 

NACA ανέπτυξε μια σειρά από καλά δοκιμασμένα αεροπορικά αεροσκάφη και 

επινόησε μια αριθμητική ονομασία για κάθε αεροτομή - έναν τετραψήφιο αριθμό 

που αντιπροσώπευε τις κρίσιμες γεωμετρικές ιδιότητες του τμήματος αεροτομής. 

Μέχρι το 1929, είχε αναπτύξει αυτό το σύστημα στο σημείο που το σύστημα 

αρίθμησης συμπληρώθηκε από μια διατομή αεροτομής και ο πλήρης κατάλογος των 

78 αεροπορικών αεροσκαφών εμφανίστηκε στην ετήσια έκθεση της NACA για το 

1933. Τα NACA airfoils είναι σχήματα αεροτομής για φτερά αεροσκαφών που 

αναπτύχθηκαν από την Εθνική Συμβουλευτική Επιτροπή Αεροναυτικής (NACA). Το 

σχήμα των αεροτομών NACA περιγράφεται χρησιμοποιώντας μια σειρά ψηφίων 

ακολουθώντας τη λέξη "NACA". Οι παράμετροι στον αριθμητικό κώδικα μπορούν να 

εισαχθούν σε εξισώσεις για να δημιουργήσουν με ακρίβεια τη διατομή του αεροτομή 

και να υπολογίσουν τις ιδιότητές του. 

Οι μηχανικοί μπορούσαν να δουν γρήγορα τις ιδιαιτερότητες κάθε σχήματος 

αεροτομής , και ο αριθμητικός προσδιοριστής ("NACA 2415", για παράδειγμα) 

καθορίζει γραμμές καμπίνας, μέγιστο πάχος και ειδικά χαρακτηριστικά μύτης. Αυτά 

τα σχήματα και σχήματα μετέδωσαν το είδος των πληροφοριών σε μηχανικούς που 

τους επέτρεψαν να επιλέξουν συγκεκριμένα αεροσκάφη για τα επιθυμητά 

χαρακτηριστικά απόδοσης συγκεκριμένων αεροσκαφών. [1] 

Κατά τη διάρκεια του Β 'Παγκοσμίου Πολέμου, η NACA περιγράφηκε ως "Η 

Δύναμη Πίσω από την Υπεροχή του Αέρα μας" λόγω του βασικού ρόλου της στην 

παραγωγή υπερσυμπιεστών για βομβαρδιστές μεγάλου υψομέτρου και για την 

παραγωγή προφίλ στρωτή πτέρυγα για τη Βόρεια Αμερική P-51 Mustang. Το NACA 

ήταν επίσης το κλειδί στην ανάπτυξη του κανόνα περιοχής που χρησιμοποιείται σε 

όλα τα σύγχρονα υπερηχητικά αεροσκάφη, και διεξήγαγε την βασική έρευνα 

συμπιεστότητας που επέτρεψε στο Bell X-1 να σπάσει το φράγμα του ήχου. 

3.2 Σχεδίαση 
     Σε αυτό το κεφάλαιο θα περιγράφει ο σχεδιασμός έξυπνης πτέρυγας σε 2D με 

διαστάσεις και μορφή ενός λειτουργικού φτερού αεροπλάνου. Έπειτα θα εξεταστεί 

και θα αναλυθεί το πως δουλεύει και μορφοποιείται η δομή του εφαρμόζοντας σε 

κατάλληλες εσωτερικές δοκούς του θερμικές φορτίσεις. 

     Οι διαστάσεις και οι συντεταγμένες των κόμβων πάρθηκαν από την εφαρμογή της 

NACA. Από την NACA 4 digit airfoil generation, αποθηκεύτηκαν οι επιθυμητοί κόμβοι 
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και συντεταγμένες που χρησιμοποιήθηκαν για την πτέρυγα σε ένα αρχείο txt κι 

έπειτα από αυτό περάστηκαν στο NX. Με τις εντολές File->Import->Points from file 

και επιλέγοντας το αρχείο txt με τους κόμβους της πτέρυγας εισέρχονται στο 

περιβάλλον του σχεδιαστικού προγράμματος. 

 

Εικ. 3.1. Εισαγωγή κόμβων. 

 Ενώνοντας τους κόμβους με την εντολή Arc, η οποία δημιουργεί ένα τόξο μέσω 

τριών σημείων ή καθορίζοντας το κέντρο και το τελικό σημείο, έχουμε το ακόλουθο 

αποτέλεσμα.

 

Εικ. 3.2. Πτέρυγα. 

     Για την σταθεροποίηση της πτέρυγας σχεδιάστηκαν εσωτερικές δοκοί με την 

εντολή Line. 
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Εικ. 3.3. Πτέρυγα με εσωτερικές δοκούς. 

3.3 Μοντελοποίηση και ορισμός παραμέτρων 

Αφού έχει ολοκληρωθεί η διαδικασία ου σχεδιασμού, ακολουθεί τοNew FEM and 

Simulation. Η κατασκευή είναι σε 2D κι έπρεπε να γίνουν κάποιες αλλαγές στο 

Geometry option, επιλέχθηκαν να εμφανιστούν τα points, lines και τα arc/circles. 

 

Εικ. 3.4. Geometry Options. 

Φτάνοντας στο παράθυρο του Solution, για να ορισμό της επίλυσης, από το 

solution type επιλέχθηκε πάλι το SOL101 Linear Statics – Global Constraints, εφόσον 

έχουμε να κάνουμε με απλή γραμμική – στατική ανάλυση. Στο Case Control -> Output 

επιλέχθηκαν οι default επιλογές. 
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Εικ. 3.5 Solution. 

3.3.1 Ανάλυση     
     Για τη δημιουργία του mesh collector επιλέχθηκε το beam collectors, το οποίο 

δίνει τη δυνατότητα τριών βαθμών ελευθερίας κάθε κόμβου. Έπειτα από αυτήν την 

επιλογή, στο κομμάτι Physical Property -> Type θα παρέμειναν οι default επιλογές. 

Στο Beam property -> none, πατώντας το Create Physical, ορίστηκαν οι παράμετροι 

του στοιχείου και το υλικό. Επίσης, ορίστηκε το Fore Section, για να δοθεί η διατομή 

στο στοιχείο, αφού θα έχει τη μορφή μίας δοκού. 

 

Εικ. 3.6. PBEAM. 

Επιλέγοντας το Show Section Manager, από το type επιλέχθηκε η διατομή ROD ίση 

με Α=0,1 m2 , δηλαδή με διάμετρο DIM1=0.1784m. 
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Εικ. 3.7. Διατομή ROD. 

Στην πορεία από την βιβλιοθήκη των υλικών, δημιουργήθηκε το συγκεκριμένο 

επιθυμητό υλικό για την πτέρυγα. Το υλικό είναι από χάλυβα με Young’s modulus 

E=200GPa, λόγο Poisson 0.2 και θερμική αντίσταση α = 13∙10−6 ℃−1. 

 

Εικ. 3.8. Βιβλιοθήκη υλικών. 
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Εικ. 3.9. Μηχανικές ιδιότητες. 

 

Εικ. 3.10. Θερμικές ιδιότητες. 

 

Σε αυτό το σημείο που έχει δημιουργηθεί το mesh collector, σειρά έχει το 1D 

Mesh. Από το element properties επιλέγεται το είδος του στοιχείου που θα 

χρησιμοποιηθεί. Απενεργοποιείται η εντολή Automatic Creation στο Destination 

Collector. 
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Εικ. 3.11. 1D Mesh. 

Έπειτα, ενώθηκαν οι κόμβοι μεταξύ των πλευρών με την εντολή merge nodes που 

βρίσκεται στο Duplicate Nodes. 

 

Εικ. 3.12. Duplicate Nodes. 

3.3.2 Συνοριακές συνθήκες και φορτίσεις 
Εφόσον έχουν οριστεί τα υλικά, από το Active Simulation έγινε η ένταξη των 

φορτίσεων (loadings) και των συνοριακών συνθηκών (boundary conditions). Από το 

Constrain Type επιλέγηκε η συνοριακή συνθήκη Fixed Constrain και εφαρμόστηκε 

στην αριστερή έξω δοκό της πτέρυγας, όπως φαίνεται και παρακάτω. 
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Εικ. 3.13. Fixed Constraint. 

 

Εικ. 3.14. Πάκτωση. 

Στην συνέχεια, εφαρμόζονται οι θερμικές φορτίσεις στις κόκκινες δοκούς της 

κατασκευής, επιλέγοντας Load Type->Temperature και βάζοντας αρχική 

θερμοκρασία ίση με 20 οC.  
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Εικ. 3.15. Temperature. 

 

Εικόνα 3.16. Θερμικές φορτίσεις. 

Για την δημιουργία της επιθυμητής θερμοκρασίας ΔΤ=3,85∙10-3 οC, από το 

Temperatures δημιουργήθηκε Now Load Set-> Temperature Set κι επιλέγοντας από 

το Type Initial/Stress Free Temperature με αρχική θερμοκρασία Default Temperature 

20 οC.  

Από το παραπάνω Temperature Set δημιουργήθηκαν δύο New Temperatures για 

τις δοκούς που θα θερμανθούν και αυτές που θα ψυχθούν κατά ΔΤ αντίστοιχα. 

Για την θέρμανση, επιλέχθηκαν οι παρακάτω δοκοί, όπως φαίνεται και στην 

εικόνα κι έπειτα ακολούθησε η αύξηση της θερμοκρασίας τους κατά ΔΤ, ίση με 

20+3.85∙10-3 οC. 
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Εικ. 3.17. Θέρμανση πορτοκαλί δοκών. 

 

Εικ. 3.18. Θερμικές φορτίσεις δοκών που θερμαίνονται. 

Για την ψύξη, επιλέχθηκαν οι παρακάτω δοκοί, όπως φαίνεται στην εικόνα κι 

έπειτα ακολούθησε μείωση της θερμοκρασίας τους κατά ΔΤ, ίση με 20-3.85∙10-3 οC.  
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Εικ. 3.19. Ψύξη δοκών. 

 

Εικ. 3.20. Θερμικές φορτίσεις δοκών που ψύχονται. 

 

Εικ. 3.21. Θερμικές φορτίσεις. 
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3.4 Επίλυση και προσομοίωση  

Σε αυτό το σημείο, εφόσον έχουν οριστεί όλα, γίνεται η επίλυση του προβλήματος 

από το Solution-> Solve. 

 

Εικ. 3.22. Επίλυση. 

 

 

 

Εικ. 3.23. Τελική παραμορφωμένη πτέρυγα.  
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ΚΕΦΑΛΑΙΟ 4:  ΕΞΥΠΝΗ ΠΤΕΡΥΓΑ 3D 

 

4.1 Σχεδίαση  
Από την NACA 4 digit airfoil generation, χρησιμοποιούνται οι ίδιες συντεταγμένες  

κόμβων με αυτές του Κεφαλαίου 3 και με όμοιο τρόπο μέσω του αρχείου txt 

περάστηκαν στο περιβάλλον του NX με τις εντολές File->Import->Points from file. 

Ενώνοντας τους κόμβους με την εντολή Arc, η οποία δημιουργεί ένα τόξο μέσω 

τριών σημείων ή καθορίζοντας το κέντρο και το τελικό σημείο, έχουμε το ακόλουθο 

αποτέλεσμα. 

 

Εικ. 4.1. Πτέρυγα. 

Έπειτα, με τη χρήση της εντολής Extrude, η οποία δημιουργεί την δυνατότητα 

εξώθησης ενός κομματιού κατά μήκος ενός διανύσματος, δόθηκε όγκος στο 

εξωτερικό της πτέρυγας. 
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=

 

Εικ. 4.2. Πτέρυγα έπειτα από την εντολή Extrude (πλάγια όψη). 

 

Εικ. 4.3. Πτέρυγα έπειτα από την εντολή Extrude (πάνω όψη). 

Στις παρακάτω εικόνες φαίνονται οι διαστάσεις τις πτέρυγας. 
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Εικ. 4.4 Πάχος εξωτερικού τμήματος της πτέρυγας. 

 

Εικ. 4.5. Φάρδος Εξωτερικού τμήματος της πτέρυγας. 
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Εικ. 4.6.  Μήκος της πτέρυγας. 

Έπειτα ακολούθησε η σχεδίαση των εσωτερικών δοκών της πτέρυγας με τη χρήση 

της εντολής Line. 

 

Εικ. 4.7. Εσωτερικοί δοκοί σε 1D. 

Σχεδιάστηκαν τρεις σειρές εσωτερικών δοκών, όπως φαίνεται παρακάτω. 
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Εικ. 4.8. Εσωτερικοί δοκοί σε 1D. 

 

Εικ. 4.9 Εσωτερικοί δοκοί σε 1D. 

Στην συνέχεια, δόθηκε όγκος στις δοκούς, με την εντολή Extrude. 
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Εικ. 4.10. Εσωτερικοί δοκοί σε 1D, έπειτα από τη χρήση της εντολής Extrude. 

 

Εικ. 4.11. Εσωτερικοί δοκοί σε 1D, έπειτα από τη χρήση της εντολής Extrude. 

Σε αυτό το σημείο εμφανίζεται ένα σημαντικό πρόβλημα στην σχεδίαση της 

κατασκευής. Το πρόβλημα αυτό είναι ότι οι δοκοί μπαίνουν μέσα σε άλλες δοκούς ή 

μέσα στο εξωτερικό κέλυφος της πτέρυγας. 



 

[41] 
 

 

Εικ. 4.12. Πρόβλημα στη σχεδίαση. 

Η λύση στο παραπάνω είναι η εντολή Trim Body, η οποία αφαιρεί τμήματα ενός 

σώματος, στην συγκεκριμένη περίπτωση θα αφαιρεθούν τα ενωμένα τμήματα. Έτσι 

προκύπτει η τελική μορφή της πτέρυγας. 

 

Εικ. 4.13. Μορφή πτέρυγας, έπειτα από τη χρήση της εντολής Trim Body. 

 

Εικ. 4.14. Τελική μορφή πτέρυγας. 
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Εικ. 4.15. Τελική μορφή πτέρυγας. 

 

Εικ. 4.16. Τελική μορφή πτέρυγας. 

 

4.2 Μοντελοποίηση και ορισμός παραμέτρων 
Αφού έχει ολοκληρωθεί η διαδικασία ου σχεδιασμού, ακολουθεί τοNew FEM and 

Simulation. Η κατασκευή είναι σε 3D και στο Geometry option παρέμειναν οι οι 

defeault επιλογές 
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Εικ. 4.17. Geometry Options 

     Στο παράθυρο του Solution, για τον ορισμό της επίλυσης, από το solution type 

επιλέχθηκε το SOL101 Linear Statics – Global Constraints και στο Case Control -> 

Output επιλέχθηκαν οι default επιλογές. 

 

Εικ. 4.18. Solution. 

4.2.1 Ανάλυση 
Εφόσον επιλέχθηκε ο τύπος της επίλυσης που θα πραγματοποιηθεί, ακολουθούν 

τα στάδια της ανάλυσης. 

Για τη δημιουργία του mesh collector επιλέχθηκε το beam collectors, το οποίο 

δίνει τη δυνατότητα τριών βαθμών ελευθερίας κάθε κόμβου. Έπειτα από αυτήν την 

επιλογή, στο κομμάτι Physical Property -> Type παρέμειναν οι default επιλογές. Στο 

Beam property -> none, πατώντας το Create Physical, ορίστηκαν οι παράμετροι του 

στοιχείου και το υλικό. Επίσης, ορίστηκε το Fore Section, για να δοθεί η διατομή στο 

στοιχείο, αφού θα έχει τη μορφή μίας δοκού.  
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Επιλέγοντας το Show Section Manager, από το type επιλέχθηκε η διατομή ROD ίση 

με Α=0,1 m2 , δηλαδή με διάμετρο DIM1=0.1784m. 

Στην πορεία από την βιβλιοθήκη των υλικών, δημιουργήθηκε το συγκεκριμένο 

επιθυμητό υλικό για την πτέρυγα. Το υλικό είναι από χάλυβα με Young’s modulus 

E=200GPa, λόγο Poisson 0.2 και θερμική αντίσταση α = 13∙10−6 ℃−1, όπως και στα 

προηγούμενα κεφάλαια. 

     Εφόσον έχει δημιουργηθεί το mesh collector, σειρά έχει το 1d mesh. Το πρώτο 

πράγμα που πρέπει να γίνει είναι από το Select Object  να επιλεχθεί ολόκληρη η 

πτέρυγα, όπου και θα γίνει το mesh. Από το element properties επιλέγεται το είδος 

του στοιχείου που θα χρησιμοποιηθεί. 

 

Εικ. 4.19. 1D Mesh. 

 

Έπειτα, ενώθηκαν οι κόμβοι μεταξύ των πλευρών με την εντολή merge nodes που 

βρίσκεται στο Duplicate Nodes. 

 

Εικ. 4.20. Duplicate Nodes. 
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Για το 2D ακολούθησε η ίδια διαδικασία με  την παραπάνω, με την διαφορά ότι 

στο collector έχει διαφορετικές επιλογές. Επιλέγεται η εντολή ThinShell, η οποία 

απευθύνεται σε επιφάνειες και πολύ λεπτά στρώματα με σκοπό να γίνει μελέτη σε 

όλους τους βαθμούς ελευθερίας. 

 

Εικ. 4.20. Mesh Collector. 

Όπως και στο 1d έτσι και εδώ θα πρέπει να οριστεί υλικό Material 1, καθώς και 

επίσης να δοθεί και το πάχος στο πεπερασμένο στοιχείο Default Thickness. 

 

Εικ. 4.21. PSHELL. 

     Ανάλογα με το collector που θα χρησιμοποιήθηκε, θα πρέπει να επιλεχτεί και το 

κατάλληλο στοιχείο στο 2d mesh. Αυτό στην συγκεκριμένη περίπτωση της πτέρυγας 

είναι το CQUAD4. Επίσης στο Destination Collector απενεργοποιείται το Automatic 

Creation. 
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Εικ. 4.22. 2D Mesh. 

Όσο αφορά το 3D Collector, δεν χρειάζεται να δοθούν χαρακτηριστικά όγκου αφού 

ήδη έχουμε solid, το μόνο που γίνεται είναι να οριστεί το υλικό κι  έπειτα από το 3d 

mesh να επιλεχθεί το επιθυμητό element που θέλεις, στην περίπτωση αυτή 

επιλέγεται το CTETRA(4). 

 

Εικ. 4.23. Mesh Collector. 
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Εικ. 4.24. 3D Tetrahedral Mesh. 

4.2.2 Συνοριακές συνθήκες και φορτίσεις 
Εφόσον έχουν οριστεί τα υλικά, έρχεται η σειρά του επόμενου βήματος, το οποίο 

είναι να εφαρμοστούν οι φορτίσεις (loadings) και οι συνοριακές συνθήκες (boundary 

conditions). Πατώντας το Active Simulation μπορούμε να προχωρήσουμε στα 

παρακάτω. 

Από το Constrain Type επιλέγω την συνοριακή συνθήκη που επιθυμώ και αυτή 

είναι Fixed Constrain, επιλέγοντας την αριστερή έξω επιφάνειας της πτέρυγας, όπως 

φαίνεται και παρακάτω στην εικόνα. 

 

Εικ. 4.25. Fixed Constraint. 
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Εικ. 4.26. Πάκτωση. 

     Στην συνέχεια, εφαρμόζονται οι θερμικές φορτίσεις στις δοκούς της κατασκευής, 

επιλέγοντας Load Type->Temperature και βάζοντας την τελική επιθυμητή 

θερμοκρασία ίση με 20+3.85∙10-3 0C. 

 

Εικ. 4.27. Temperature. 

 

Εικ. 4.28. Θερμικές φορτίσεις. 
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Για την δημιουργία της επιθυμητής θερμοκρασίας ΔΤ=3,85∙10-3 0C, από το 

Temperatures δημιουργήθηκε Now Load Set-> Temperature Set κι επιλέγοντας από 

το Type Initial/Stress Free Temperature με αρχική θερμοκρασία Default Temperature 

20 0C και ένα Temperature Set επιλέγοντας από το Type Temperature Load με 

θερμοκρασία επίσης 20 0C. 

Από το παραπάνω Temperature Set – Temperature Load δημιουργήθηκε ένα νέο 

Temperature για τις δοκούς που θα θερμανθούν κατά ΔΤ. 

Για την θέρμανση, επιλέχθηκαν οι παρακάτω δοκοί, όπως φαίνεται και στην 

εικόνα κι έπειτα ακολούθησε η αύξηση της θερμοκρασίας τους κατά ΔΤ, ίση με 

20+3.85∙10-3 0C. 

 

Εικ. 4.29. Θέρμανση δοκών. 

 

Εικ. 4.30. Θερμικά φορτισμένες δοκοί. 
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Εικ. 4.31. Θερμικά φορτισμένες δοκοί. 

 

Έπειτα, με την εντολή Simulation Object Container, δημιουργήθηκαν οι 

προσομοιώσεις των κομματιών της κατασκευής. 

 

Εικ. 4.32. Simulation Object Container. 

Τελευταίο βήμα πριν την επίλυση, είναι η χρήση της εντολής Region, η οποία έχει 

την δυνατότητα να ενώσει όλα τα διαφορετικά κομμάτια της κατασκευής και να 

θεωρούνται ένα ενιαίο σώμα. 
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Εικ. 4.33. Region. 

4.3 Επίλυση και προσομοίωση 
Σε αυτό το σημείο, εφόσον έχουν οριστεί όλα, ακολουθεί το τρέξιμο του 

προγράμματος, από το Solution-> Solve με τα ακόλουθα αποτελέσματα. 

 

Εικ. 4.34. Παραμορφωμένη πτέρυγα με Scale 2 (με το γκρι χρώμα αρχική κατασκευή). 



 

[52] 
 

 

Εικ. 4.35. Παραμορφωμένη πτέρυγα με Scale 2 (με το γκρι χρώμα αρχική κατασκευή). 

 

 

Εικ. 4.36. Παραμορφωμένη πτέρυγα με μεγάλο Scale. 
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Εικ. 4.37. Παραμορφωμένη πτέρυγα με μεγάλο Scale. 

 

Στην παρακάτω σειρά εικόνων, φαίνεται η σταδιακή παραμόρφωση της πτέρυγας. 

 

Εικ. 4.38. Animation Frame 1 of 8. 
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Εικ. 4.39. Animation Frame 2 of 8. 

 

 

Εικ. 4.40. Animation Frame 3 of 8. 
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Εικ. 4.41. Animation Frame 4 of 8. 

 

 

Εικ. 4.42. Animation Frame 5 of 8. 
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Εικ. 4.43. Animation Frame 6 of 8. 

 

 

 

Εικ. 4.44. Animation Frame 7 of 8. 
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Εικ. 4.45. Animation Frame 8 of 8 
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ΣΥΜΠΕΡΑΣΜΑΤΑ 
Από τα αριθμητικά παραδείγματα και τα σχεδιαστικά αποτελέσματα, φαίνεται ότι η 

θερμική παραμόρφωση των στοιχείων ράβδου μιας κατασκευής, μπορεί να χρησιμοποιηθεί 

ως πρωτότυπο για τον υπολογισμό της στατικής μορφοποίησης των έξυπνων πτερυγίων, με 

την έννοια ότι μπορούν να τροποποιήσουν το σχήμα του.  Φυσικά, άλλες τεχνολογίες όπως 

πιεζοηλεκτρικά υλικά ή SMA μπορούν να χρησιμοποιηθούν με ελαφρά τροποποίηση του 

προτεινομένου μοντέλου.  Σε δυναμικά προβλήματα, η μορφοποίηση μπορεί να επιτευχθεί 

χρησιμοποιώντας τον βέλτιστο έλεγχο η πιο γενικά τεχνικές χαλαρού υπολογισμού όπως 

ασαφείς και νεύρο-ασαφείς τεχνικές. Σε αυτήν την περίπτωση δεν μπορεί να 

πραγματοποιηθεί γρήγορη απόκριση με θερμική ενεργοποίηση. Παρ όλα αυτά, η έννοια της 

αρχικής προέντασης ή παραμόρφωσης για την εφαρμογή της δράσης ελέγχου ισχύει ως 

κατάλληλο υπολογιστικό εργαλείο. Επιπλέον, η χρήση ήπιων υπολογιστών και εργαλείων 

τεχνητής νοημοσύνης θα επιτρέψει την εύκολη συγχώνευση μετρήσεων και δεδομένων, με 

τη σειρά να ληφθούν υπόψη πιο περιπλοκές εργασίες αλληλεπίδρασης ρευστού-

κατασκευής. Η σύζευξη του ελέγχου σχήματος και της δυναμικής μορφοποίησης 

αντιπροσωπεύει μια περιοχή ενδιαφέροντος μελλοντικής έρευνας. 
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